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About this course
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Objectives of the course



Upon completion of this course, you will be able to: -Use 3D reference Elements to create a part -Create advanced Sketch-Based Features -Apply Advanced Dress-Up Features -Design using Boolean operations -Share Designs by working in Multi-Model environment -Analyze Parts -Annotate Parts for review



Targeted audience



CATIA V5 Mechanical Designers
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Prerequisites



Students attending this course should have the knowledge of CATIA V5 Fundamentals, Getting started with CATIA V5, Sketcher, Part Design Fundamentals
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1.5 Days
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Table of Contents (2/3) Sketch Based Features: Recap Exercises Sum Up



Part Manipulations Introduction to Part Manipulations Scanning a Part Design Using Boolean Operations Cut, Paste, Isolate, Break Sharing Geometries Sketch Selection with Multi-Document Links Part Manipulations Recommendations Part Manipulations: Recap Exercises Sum Up
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Table of Contents (3/3) Dress Up Features Recommendations Dress-Up Features: Recap Exercises Sum Up



Part Analysis Introduction to Part Analysis Analyzing Threads and Taps Draft Analysis Surfacic Curvature Analysis Part Analysis: Recap Exercises Sum Up
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Using 3D Elements to Create a Part
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You will learn how to use 3D elements to create solids based on



Introduction to Using 3D Elements to Create a Part Local Axis 3D Wireframe Elements Holes/Pads not Normal to Sketch Plane Creating Pads and Pockets from Surfaces Surface-Based Features 3D Constraints Using 3D Elements To Create Parts Recommendations Using 3D Elements to Create a Part: Recap Exercises Angle Bracket Sum Up
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Introduction



Part creation is frequently based on 3D wireframe elements like lines or planes or on surfaces :



You will see how to create 3D wireframe elements and how to create local axis used to position geometries.
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You will see how to create solid based on existing surfaces and how to position 3D geometries with regards to planes or surfaces.
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Local Axis
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You will learn how to create a local axis in order to define local coordinates
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What is a Local Axis ?
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It is possible to create a local axis in order to define local coordinates. For example, it is, sometime, easier to build a point by coordinates in a local axis rather than creating it in the absolute coordinates system
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Point created in the local coordinates system
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Local Axis : Creation It is possible to create a local axis in order to define local coordinates. For example, it is, sometime, easier to define point coordinates with respect to a local axis rather than to the absolute coordinates system



1



Select the Axis System icon



2



Select the local axis origin point



3



Select the OX direction



(2)



(3)



4



Select the OY direction



5



Select OK in the dialog box
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You get :



(4)
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(5)
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Local Axis : Use It is possible to create a local axis in order to define local coordinates. For example, it is, sometime, easier to define a point coordinates with respect to a local axis rather than to the absolute coordinates system Set the axis system As the Current one with the contextual menu
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1
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(1)



2



Using the Point function (Coordinates options), create a point with X=0, Y=0 and Z=100



You get :
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Local Axis-System Setting (1/3) Check the ‘Create an Axis-System when creating a new part’ option if you wish to create a three axis-system which origin point is defined by the intersection of the default planes that are plane XY, plane YZ and plane ZX
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1
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Select Tools -> Options
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Local Axis-System Setting (2/3) 2



In the Options dialog box, select Infrastructure > Part Infrastructure > select Part Document tab



3



Select the Create an Axis System when creating a new part option



4



Select OK
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Local Axis-System Setting (3/3) 5



Select the File -> New command



6



Double click on Part in the dialog box
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The local axis is automatically created:
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3D Wireframe Elements
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You will learn more about 3D wireframe elements and how to use them to construct your part.
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What are 3D Wireframe Elements ? In the Part Design workbench, you can create points, lines and planes without using the Sketcher workbench but by using the “Reference Element” toolbar. Points ,lines and planes created using reference toolbar are 3D elements can be used for reference purpose. For Instance, you can use this toolbar to create a plane at an angle ,and sketch on this plane when existing surfaces of the part do not provide an appropriate sketch plane for the creation of a feature. You can use the 3D reference line to create a pad in a direction other than the direction normal to the sketch.



Copyright DASSAULT SYSTEMES



The Specification tree: When Points and lines are created in sketcher workbench using profile toolbar.



Point and line created in sketch
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The Specification tree: When Points lines and planes are outside the sketcher workbench using reference elements toolbar



Point and line created using reference elements
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3D Reference Elements (1/4) 3D reference elements are used mainly to reduce the impact of deletions and optimize the designing of parts and their modifications. They are used to ensure consistent parent children relationships. First case



Create a Base Pad from the sketch shown.



Create a sketch on the top face of Base Pad. Constrain the sketch completely using the edges of the Pad. Using this sketch a Upper Pad.
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Create a sketch on the top face of Upper Pad. Create a Pocket
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Create the holes on the top face of the Upper pad. Dimension the holes with respect to the Pad edges.
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3D Reference Elements (2/4)



The upper pad is dependent on the Base Pad.



The Pocket is dependent on the Upper Pad.
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Now when we try to delete the Upper Pad, an update error is displayed.



Copyright DASSAULT SYSTEMES



On deletion of Parent feature, the children features are affected.



Part Design Student Notes:



3D Reference Elements (3/4) Second case Top Reference Plane



Create a Base Pad from the sketch shown. Create a ‘Sketch’ for ‘Upper Pad’ on the bottom reference plane. Dimension the Sketch with reference to standard Planes. Create ‘Upper Pad’ using this ‘Sketch’.



Bottom Reference Plane
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Create a ‘Sketch’ for ‘Pocket’ on the top reference plane. Dimension the Sketch with reference to standard Planes. Create ‘Pocket’ using this ‘Sketch’.



Create the holes on the top face of the ‘Upper Pad’. Dimension the holes with respect to the standard Planes.



The sketch created is independent of the parent Pad but is created with the help of reference elements
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3D Reference Elements (4/4) The upper Pad Sketch is created on reference Plane and independent on the Base Pad.



The Pocket Sketch is created on reference Plane and independent on the Upper Pad.



On deletion of the first feature Upper Pad, the pocket is not affected.
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So parts created using reference elements are more stable.
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The upper pad is created on Reference elements and is independent of first feature.
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Creating 3D Wireframe Points 1



In the Reference toolbar, select Point by clicking on the icon



2



A dialog Box is displayed



3 Notice that you can choose from several options from the drop down menu
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The created point appears under part body.
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Creating 3D Wireframe Lines 1



In the Reference toolbar, select Line by clicking on the icon



2



A dialog Box is displayed



Notice that you can choose between several types of line



The created line appears under part body due to hybrid nature
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3
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Creating 3D Wireframe Planes 1



In the Reference toolbar, select Plane by clicking on the icon



2



A dialog Box is displayed



Notice that you can choose between several types of planes



The created plane appears in the part body because of hybrid nature
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3
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Using 3D Wireframe Elements to Create a 3D Curve



1



You can create points according to their coordinates by using the Points tool in the Reference Element tool bar 2
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This curve can now be used to extrude a rib or create a slot
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Create the 3D curve by using the 3D Curve tool in the Free-Style workbench
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Holes/Pads not Normal to Sketch Plane



Copyright DASSAULT SYSTEMES



You will learn how to create Holes, Pockets or Pads with a direction of extrusion not perpendicular to their sketch
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What are Holes/Pockets/Pads not Normal to the Sketch Plane ?



Some Key Points: •
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When creating a hole, a pocket or a pad, the default result is perpendicular to the sketch you have selected to get these features • It is possible to define another direction. You specify it in the Direction field • The selected direction must neither be in a plane parallel to the sketch plane nor in the same plane
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Holes/Pockets/Pads not Normal to Sketch Plane 1



If a Pad or Pocket, select Profile sketch to be used



2



Select the appropriate icon



3



For this geometry, modify definition to include type “Up to Plane” and select



4 Changes the extrusion direction



Copyright DASSAULT SYSTEMES



You get:
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5



Select limit surface on part



De-Select “Normal to Sketch” and select reference
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Do It Yourself (1/3) Part used: Pockets_Not_Normal_to_sketch_plane_Do_It_Start.CATPart First, you will design a Hole along a direction provided to you. Create Hole on this Pads face



Create the Hole along this direction
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Locate the sketch for the hole on Pads face and constrain it with the planes and as shown:
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Plane.1
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Do It Yourself (2/3)
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Create the Hole along the direction shown.



This Line is provided in the Geometrical set



Copyright DASSAULT SYSTEMES



Student Notes:



Part Design Student Notes:



Do It Yourself (3/3) Now you will create Pocket not normal to sketch plane. Insert Body.2 Use following sketches provided in the Geometrical set: “Sketch_For_Pocket” as profile for the pocket and “Direction_For_Pocket” as the direction for the pocket



Sketch_For_Pocket
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Now you can apply tri-Tangent fillet to the Pockets and Pattern them using Circular pattern. Finally, assemble this body with the part body.



Pockets_Not_Normal_to_sketch_plane_Do_It_End.CATPart
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Creating Pads and Pockets from Surfaces
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You will learn how to create Pads and Pockets from Surfaces
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How to Create Pads and Pockets from Surfaces ? You can extrude surfaces in any direction. Images below show you how to create pads from surfaces. The same method can be applied to pockets.



Copyright DASSAULT SYSTEMES



Up to Plane
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Up to Last



Pocket from a Surface (Up to Plane)



Up to next
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Creating Pads and Pockets from Surfaces (1/2) 1



Select the Surface to be extruded.



2



Select the Pad icon.



3



The Pad Definition dialog box appears. Select the “Up to surface” limit and the surface of your choice. According to the example, you can use another limit type (Dimension limit, Up to next, Up to last, Up to plane …)
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Creating Pads and Pockets from Surfaces (2/2) Expand the dialog box. Click the Reference Field and select the extrusion direction.



5



Enter the first and the second limit values and click OK to confirm.
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4
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Do it Yourself Part used: Pad_from_Surface_Do_It.CATPart Create a Pad from the ‘Fillet’ surface in the ordered geometrical set. Create a pad upto XY plane and Use direction as XY plane.
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Surface to Pad



Copyright DASSAULT SYSTEMES



XY plane
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Surface-Based Features
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You will learn how to create advanced types of Surfaced-Based feature: Split, Thick Surfaces, Close Surfaces and Sew Surfaces.
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What is a Surface Based Feature and When to Use It (1/2) ? There are four Surface Based Features • Split: Used to split a solid with either a plane or a surface.
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• Thick Surface: Used to create solids from surfaces. Material can be added from either or both sides of the surface
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What is a Surface Based Feature and When to Use It (2/2) ? • Close Surface: Used to take a closed surface and turn it into a solid.
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• Sew Surface: Used to glue a surface feature to an existing 3D solid.
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Split 1



Select body to be split



3



Select the splitting element



An arrow pointing to the material to keep appears. Click on it to reverse the direction if needed
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2



Select Split icon



You can split a body with a plane, face or surface. A typical use is where the internal structure must be trimmed and associated to an outer aerodynamic shape to allow rapid future change.
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Thick Surface 1



Select the surface to be thickened.



2



3



Enter the offset thickness values.



4



Select the Thick Surface icon.



Second thickness value. First thickness value.
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The resulting feature does not keep the color of the original surface.
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Close Surface Select Close Surface icon



3



Closed Surface appears in specification tree
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1
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2



Select surface to be closed
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Sew Surface 1



3



Select the Sew Surface icon



2



Select the surface to sew



The Final solid is as follows



An arrow pointing to the material to keep appears. Click to change the direction if needed.
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Two options are available in the Dialog Box : Intersection and Simplify geometry. After clicking on the Intersection option, the Surface will be glued to the existing 3D Solid even if this Surface intersects the Solid.
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Sewing means joining together a surface and a body. This capability consists in computing the intersection between a given surface and a body while removing useless material
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Do It Yourself



Split and Thickness surface



Sewing Surface
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• Using the “Split and Thickness” surface create a Split of the left pad and then create a Thickness from the same surface (3 mm thick) • Use the Sewing surface to create a curved surface on the end of the part using Sew
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3D Constraints
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You will learn how to use 3D constraints
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What is a 3D Constraint ? A 3D Constraint is the same as any other constraint only that it is applied in the 3D model itself. Basically you will note that some are reference type constraints and others are regular constraints. Creation is the same as in the Sketcher, so we will concentrate on their usage here



Reference constraints are shown in parenthesis and cannot be modified
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They are references because there are other constraints that are constraining the geometry



Normally, 3D constraints are modifiable and can be linked and driven as others are in the Sketcher
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When to Use 3D Constraints ? They can be used whenever you have 3D geometry that you want to link to some type of 3D datum plane or surface
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They are also useful when you need to drive the location of a piece of geometry created earlier in the design from a piece of geometry created later in the model. Thus this will limit some of the need to re-ordering of the part You may also find it useful when you are using Copy and Paste to locate the pasted piece of Geometry from where you wish
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Creating 3D Constraints 1



Select the Constraint icon and create a constraint between the left side face and the hole on the left side of the part
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2



Now, Create one more 3D constraint between the same face and Hole on right side



The first dimension created was not a ‘reference’ dimension. No Parenthesis were on the value. The second dimension was a ‘reference’ dimension because the sketch of right side hole is constrained from right side face.
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Using 3D Constraints 1



You will drive the location of Pocket.1 from Hole.2 created after it in the tree



2
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3 Note: This capability will allow you to drive location of features in the tree from features created after them without having to do re-location of features in the tree.
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Create the two constraints shown below from the center line of Hole.2 to the edges of the Pocket.1



Modify the constraint indicated in red to 25mm and the Pocket.1 is now driven from the Hole.2 location
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Exercise 3D Constraint Creation : Recap Exercise



15 min
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Creating some 3D constraints to drive the location of the pads created before the holes from the hole location
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Do It Yourself CATPDGEX3d_Constraint_start.CATPart.CATPart



Hole
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Pad



• Constrain the Pad to the hole so that if the hole moves the pad moves with it • Note that the Pad must be created before the hole so that the hole will pass through it after creation
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Using 3D Elements Recommendations
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You will see some hints, tips and advices about tools seen in the lesson
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Defining Local Axis Local Axis dialog box



To define the axis system origin To define the OX axis To define the OY axis To define the OZ axis
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To expand the dialog box
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To reverse the OX axis



To reverse the OY axis To reverse the OZ axis
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Creating Midpoint or Endpoint to Define Axis System Origin You can define Endpoints or Midpoints as origin points of Axis Systems.



1



Select the Insert -> Axis System command or click on the Axis System icon.



3



2



The Axis System Definition dialog box is displayed.



5



With the option Create Endpoint : the origin point corresponds to the endpoint detected by the application after selection of a geometrical element.



Use the contextual commands available from the Origin field to define the origin point. You can see that two new options have been added in V5R10 : Create Midpoint and Create Endpoint.



4 With the option Create Midpoint : the origin
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point corresponds to the midpoint detected by the application after selection of a geometrical element.
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Using 3D Elements to Create a Part: Recap Exercises You will Practice the concepts learnt in this lesson to build a exercise following a recommended process.
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Curved Mating Piece
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Curved Mating Piece Using 3D Elements to create a part: Recap Exercise 25 min
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In this exercise you will: Design the part to connect two different components. A reference surface is provided. Create a pad using the surface provided. Create 3D wireframe elements to assist designing of the mating Rib. Create Axis system and 3D points to locate tapered holes. Apply fillets.



Copyright DASSAULT SYSTEMES



Student Notes:



Part Design Student Notes:



Design Process: Curved Mating Piece 1 Create a solid feature from a surface 2 Create 3D elements to create a Rib



3
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Create a Axis system to support the development of other feature
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4 Add final dress-up features to complete the design
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Do It Yourself (1/12) PDG_Curve_mating_Piece_Start.CATPart
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Set the Length units to “Inches”, using: Tools > Options > Parameters and Measure > Units. Create a wireframe plane offset from XY plane at a distance of 3 inches downwards. Rename the PartBody as “Main Body”.
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Plane.1
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Do It Yourself (2/12) Create a line normal to the surface Line type option: Normal to surface Select surface.1 To select a point on this surface, you need to create the point using stacking of commands. Access the contextual menu and select “Create Point”. Select Point type: On Surface
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Point.1
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Line.1
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Do It Yourself (3/12) Create a pad from the surface and select direction as line.1 up to plane.1



Surface.1
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Plane.1



Now, you will create a Rib. So, you will first design the center curve and then the profile for the Rib
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Do It Yourself (4/12) Create a Rib along the top surface of the Pad that is designed to clip into another part. The transition for the center curve is offset asymmetrically from the ends. Create 3Dpoint on the edge of the of the pad. Create the point on the edge of the pad using “On curve “ option. Key in length 0.25in.



Point.3
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Create another 3Dpoint on the opposite edge of the of the pad.
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Point.2
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Do It Yourself (5/12) Create a 3D line through these points and lying on pad top surface. This is the center curve for the Rib.



Point.3
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Point.2
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Do It Yourself (6/12) Now you will create a profile on the face of the pad in Main Body.



Profile for the Rib



Copyright DASSAULT SYSTEMES



Create sketch on this face.



Copyright DASSAULT SYSTEMES



The sketch Details are:
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Do It Yourself (7/12) Create a Rib from the profile and center curve.



Reference Surface



Line.1
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Sketch.1



The center curve must lie on reference surface
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Do It Yourself (8/12) Note how the opposite end of the Rib overhangs the Pad. You will use this face of the Rib to extrude a new Pad down to the base of the first Pad. Note the warning message.
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This face overhangs the Pad.
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Select this edge as direction.
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Do It Yourself (9/12)
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Now you will create an Axis System and 3D Points to help you place two tapered holes.



Copyright DASSAULT SYSTEMES



Student Notes:



Part Design



Do It Yourself (10/12) Now create two points in this axis system to locate the centers of two holes which you will create. Point.4 (0.45, 1, 0) Point.5 (0.45, 2.5, 0)



Point.4
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Point.5
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Do It Yourself (11/12) Use the hole tool to create a tapered hole on this face, coincident with the bottom 3D Point. (Hint: Select the hole tool, the reference 3D Point and then the face and the coincidence constraint will be automatically created.) Select the hole parameters as shown below: Blind Hole. Create it along pad edge. Diameter of 0.4 in Depth of 1in Tapered hole with angle of 15 deg. Similarly, create another hole using point.5
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Hole.2
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Hole.1



Direction
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Do It Yourself (12/12) Apply an Edge fillet to the two edges of 0.125 in as shown.
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Select these two edges



PDG_Curved_Mating_Piece_End.CATPart
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Angle Bracket Part Design Fundamental Exercise 40 min



In this exercise you will build the Angle Bracket by following a recommended process. You will first understand the design intent of the Angle Bracket and identify its functional features. You will then study its Drawing in detail to understand the dimensions and specifications. Finally,you will design the various functional features of the Angle Bracket according to specifications and by making use of wireframe elements. Here you will :
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Design the base pad. Design the thin pad. Apply Fillets. Design bracket pad. Design pilot and Bracket Holes.
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Design intent: Angle Bracket Thin Flange



Bracket Pads



Bracket Holes



Base Pad Fillets
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Pilot Holes



Angled Bracket is a Machined component. Angle Bracket is used in structures. Base pad is used for clamping and for providing support. Bracket Pad is used to hold Pins.
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Angle Bracket Drawing
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Understand the drawing thoroughly to design the part according to the specifications.
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Design process: Angle Bracket (1/2) 1



Create Wireframe specifications.



2 Design the Base Pad 3
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4



Design the Thin Flange



Apply Fillets



Copyright DASSAULT SYSTEMES



Part Design Student Notes:



Design process: Angle Bracket (2/2) 5



Design the Bracket Pad



6 Design the Pilot Holes Design the Bracket Holes
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7
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Step 1: Create Wireframe Specifications (1/3) PDG_Angle_Bracket_Understanding_Design_Intent.CATPart. Open the part and understand the design intent behind the design. (The part has no history) In a new Part, create a reference point with coordinates (76,0,0) in a Geometrical set. Create another point at origin. Create a line joining point.1 and Point.2.
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Point.1



Point.2
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Point.2



Point.1
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Step 1: Create Wireframe Specifications (2/3) Create a Point on line.1 at a distance of 27 mm form Point.2. This is Point.3. Create a Line.2 of length 20 mm using “Point-direction” option.Use Point.3 and Z axis. Create a Plane using YZ plane as reference and Line.2 as rotation axis.Rotation angle = 24 deg.
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Point creation
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Line creation



Plane creation
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Step 1: Create Wireframe Specifications (3/3) Create a plane at a distance of 65 mm from ZX Plane. Create a plane at a distance of 8 mm from ZX Plane. Plane.2 and Plane.3 are on either side of ZX Plane.



Plane.2



ZX Plane



Copyright DASSAULT SYSTEMES



Plane.3
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Step 2: Design the Base Pad Create a positioned sketch on XY Plane. Use Part origin and orient with X axis. Use previously created wireframe elements to constrain the sketch. Pad this sketch by a value of 4 mm in Part Body. This is the Base Pad. Make this line coincident with Plane.3



Make center of the arc coincident with Point.1



Plane.2 Plane.3
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Plane.1



Make this line coincident with Plane.2
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Make this line perpendicular with Plane.1
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Step 3: Design the Thin Flange Create a positioned sketch on YZ Plane. Use Part origin and Orient with Y axis. Use Plane.2 and Plane.3 to constrain this sketch. Pad it by 3 mm. This is Thin Flange Pad. Sketch for thin Flange Plane.3



Details
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Plane.2
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Step 4 & 5: Applying Fillets and Design the Bracket Pad (1/3) Create a Point.4 on Plane.1 (H = - 35 and V = 20 mm). Use Point.3 as reference point. This Point is Used later in the step. Apply a Edge Fillet of 8 mm and 6 mm to the edges shown. Create a positioned sketch on Plane.1.This is sketch.3. Use Point.4 to constrain the sketch. 6 mm fillet 8 mm fillet



Point.4
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Constrain with Point.4
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Constrain this line Pad.1 edge
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Step 4 & 5: Applying Fillets and Design the Bracket Pad (2/3) Create Plane.4 offset from Plane.1 at a distance of 6 mm. Create a Plane.5 offset from Plane.4 at a distance of 4 mm. Pad sketch.3 by making use of Plane.4 and Plane.5 as limits. This is Pad.3



Plane.1 Plane4 Plane.5



Sketch.3 Plane4
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Plane.5
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Step 4 & 5: Applying Fillets and Design the Bracket Pad (3/3) Create Plane.6 offset from Plane.1 at a distance of 6 mm. Create a Plane.7 offset from Plane.6 at a distance of 4 mm. Pad sketch.3 using Plane.6 and Plane.7 as limits. This is Pad.4. Apply Edge Fillet of 6 mm and 2 mm on the edges shown. Plane7 Plane 6
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Fillet of 6 mm.
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Fillet of 2 mm to four edges shown
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Step 6: Design the Pilot Holes Design the pilot hole of diameter 5 mm. Create a Point in Geometrical set on Line.1 at a distance of 52 mm using Point.2 as reference point.This is Point.5. Create a sketch(consisting of points) in Geometrical set to pattern the pilot hole. Use Previously Created points to constrain the points in the sketch. Make this point coincident with Create a User Pattern of pilot hole using the above sketch.
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Make the hole center coincident with Point.1
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Point.5



Make this point coincident with Point.3



User Patterned holes
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Step 7: Design the Bracket Holes
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Design the bracket hole of 6 mm upto Plane.7 Make the center of the hole coincident with Point.4



The Resulting Part: PDG_Angle_Bracket.CATPart
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To Sum Up This concludes the lesson on Using 3D elements to create Part



Local axis is used to define local co-ordinates . It is helpful create elements in reference with local system rather than absolute system. Points,Lines and planes are used as reference elements to facilitate design.They also used for effective parent-children management. You have seen how to create holes in a direction other than the direction Normal to sketch using 3d elements and also how to generate Pads and Pockets from surfaces. In surface based features you have seen close surface,split surface,Thick surface and fill surfaces.
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Split Surface :Used to split solid with a surface or a plane. Thick surface:Used to create solids from surfaces by adding material in both the directions. Close surface :Used to create a solid by closing a surface . Sew surface:Used to glue a surface to a solid.
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Sketch-Based Features You will learn how to create advanced sketch-based features
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Introduction to Sketch-Based Features Creating Ribs and Slots Creating Stiffeners Creating Multi-sections Solid Sketch Based Features Recommendations Sketch Based Features: Recap Exercises Sum Up
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Introduction Following advanced tools are Sketch Based and allow you to create complex parts:



Ribs and Slots: These tools allow you to create complex ribs and slots on existing solids or to create pipes:
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Stiffeners: This tool is useful when you want to rigidify a thin solid:



Multi-sections Solids This tool is used to create complex solid using a set of sections
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Creating Ribs and Slots You will learn how to create Ribs and Slots
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RIB
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SLOT



Part Design Student Notes:



What is a Rib A Rib is a profile swept along an open or closed Center Curve to create a 3D feature The profile can be swept along an open or a closed center curve to create the feature.



Profile Center curve
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The profile of the Rib can be controlled by simply using one of the 3 choices under the Profile control section of the window



The center curve does not have to extend to the end, merge Ends can be used to extend or shorten the rib to its proper wall.
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What is a Slot A Slot is a profile that is swept along an open or closed Center Curve to remove material from a solid



The profile can be swept along an open or a closed center curve to remove the material.
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The profile of the Slot can be controlled by simply using one of the 3 choices under the profile control section of the window



The center curve does not have to extend to the end, merge ends can be used to extend or shorten the slot to its proper wall



Copyright DASSAULT SYSTEMES



Student Notes:



Part Design



When Should We Use Ribs and Slots You will find Ribs useful when you need to sweep profiles from one surface to another. Ribs and Slots will also be useful to create complex walls of parts that have many details in them. Here you can control complexity in one sketch and does not require many small sketches or geometric features to work with.



Copyright DASSAULT SYSTEMES



Also a Rib can be used to create a pipe by sweeping a profile along a center curve.
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How to Create a Simple Rib 1



Set the Pulling direction by selecting the indicated surface
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3



Select the Rib icon.
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2



4



Select the Profile to be swept and the 3D center curve along which it will be swept.



Click OK to validate the Rib



The 3 Dimensional curve was created in the Wire Frame workbench.



Part Design Student Notes:



How to Create a Slot 1



Select the Slot icon



The depth of the profile must be equal to or less than the radius of the Center Curve.



The Result is:
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3
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2



Select the Profile to be swept and also the path along which slot will be creates.
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Creating Thin Ribs and Slots (1/3) Thin Ribs and Slots are resulting features from adding thickness to both sides of Rib’s and Slot’s profiles.
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You can create a Thin Rib or Slot after checking the Thick Profile option
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You then obtain your Thin Rib or Slot.
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Creating Thin Ribs and Slots (2/3) 1



Select the Rib icon



2



Select the Profile you want to sweep and the Center curve in the Rib definition Dialog Box.



3



Enter values for Thickness1 and Thickness2. You can see that material is added on both sides.
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4



To define Thin Rib check Thick Profile option
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Creating Thin Ribs and Slots (3/3) 5



To add material equally to both sides, check Neutral Fiber. The thickness1 you defined is now distributed equally. Note that Thickness2 is not available.



If you click on the “Merge Ends” option, you will trim the Rib to existing material.



6



Click OK to create your Thin Rib.
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This task can also be applied on Slots . The Thin Slot looks like this.
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Do It Yourself CATPDGEXRib_Slot_Start.CATPart.CATPart Sketch.3



Sketch.1



Sketch.2
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• Create a Rib using Sketch.1 and Sketch.2 • Create a Slot using Sketch.3 along sketch.1



RIB
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SLOT
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Creating Stiffeners
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You will learn how to create Stiffeners
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What is a Stiffener ? A Stiffener is a brace or rib that is added to a wall or a stand-off to strengthen them so as to prevent breakage. It is commonly found on molded plastic parts or castings
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These two arrows are used to control the width of the part, which can be either symmetrical or only on one side.



As with most features you can now access the sketch directly by selecting this button.
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The other arrow is used to control the direction of the rib.



Part Design



When Should we Use Stiffeners ?



Copyright DASSAULT SYSTEMES



They can be used when you have a thin wall that you want to be more rigid without increasing the thickness of the wall



They can also be used for tall objects that are used to locate or support other objects and you want to prevent them from breaking off the surface they are attached to
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Creating Stiffeners (1/2) 2



1



Select the Stiffener Icon



3



The Stiffener Definition Dialog box is displayed. Two Creation Modes are available : ‘From Side ‘and ‘From Top’.



Select the sketch



You will find that in many cases you need to add a small line segment on to the top of the angled line used to create your stiffener. This allows for a coincidence constraint to be created between the rib and the part.
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Creating Stiffeners (2/2) 4



The ‘From Side’ option is the default one in CATIA. It is used to create “former” Stiffeners. The extrusion will be made in two Directions if the Neutral Fiber is uncheked, otherwise in three Directions. Select the thickness value. If the direction is correct select OK to create the Stiffener.



The option ‘From Top’ allows you to create Stiffeners from a Network. It is never done with respect to the Creation order Profile. The extrusion is performed normal to the Profile’s Plane and the Thickness is added in the Profile Plane.
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5
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Do It Yourself CATPDGEXStiffener_start.CATPart • Create a Sketch on the Plane as shown • Create a Stiffener of thickness 1 mm using this sketch. Sketch
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Plane
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Stiffener
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Creating Multi-sections Solid You will learn how to create Multi-Sections Solids and Removed Multi-Sections Solids
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Creating Simple Multi-sections Solids Remove Multi-sections Solids Coupling Changing the Closing Point Do it Yourself
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Creating Simple Multi-sections Solids
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You will learn how to create Multi-sections Solids
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What is a Multi-sections Solid? A Multi-sections Solid can be a Positive (add material) or Negative (subtract material) solid that is generated by two or more planar sections swept along a spine. In P1 configuration, only two sections Multi-sections Solid can be created.



Guide Line
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Closing Point
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Directional arrows are provided to get the proper orientation of the Multi-sections Solid. The Planar sections can be connected with Guide Lines. Note that Closing Points on the sketch must be aligned to get the proper orientation of the sections otherwise the Multi-sections Solid gets twisted.
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When to Use Multi-sections & Removed Multi-sections solids Multi-sections Solids can be used for several reasons: To create complex solids.
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To create some transition geometry between two existing solids in a part



Removed Multi-sections Solids are used the same way when you want to subtract a transitioned surface from another solid.
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Multi-sections Solid Creation: Guide Lines 1



Select the Multi-sections Solid icon



3



Select the Guide tab from the dialog box



2



Select the sections through which the Multisections Solid is going to pass. The order in which you select the sections is important, it will define the order of connection between the sections



(2a) (2b)
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4
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Select the Guide lines



The Multi-sections Solid passes through the sections and it is limited by the guide lines



(2c)
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Multi-sections Solid Creation : Spine 1



Select the Multi-sections Solid icon



2



Select the sections the Multi-sections Solid is going to pass through. The order in which you select the sections is important, it will define the order of connection between the sections



(2b) (2c)



(2a)



3



Select the Spine tab from the dialog box



4



Select the Spine
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Spine
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From the first to the last section, the solid is generated by doing a sweep along the spine. The sections always stay fix in space
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Multi-sections Solid Creation: Closing Point & Orientation
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Closing point of the section



Orientation of the section



When selecting another section, it might happen that the section is orientated in the other direction than the previous one, so, to reverse the section orientation select the arrow which indicates the section orientation
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To change the closing point of a section, select another point on this section
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Multi-sections Solid Creation : Tangent Surfaces



1



Select the first section



2



Select the surface (corresponding to the first section) the Multi-sections Solid will be tangent to



3



Select the intermediate sections



4



Select the last section



5



Select the surface (corresponding to the last section) the Multi-sections Solid will be tangent to



6



Validate



You get : Result with the same sections but without any tangent surfaces (2)



(3)



(4)



(5)
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(1)
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Removed Multi-sections Solids
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You will learn how to create Removed Multi-sections Solids
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What is Remove Multi-sections Solid Material ? The Removed Multi-sections Solid capability generates Multi-sections Solid material, by sweeping one or more planar section curves along a computed or user-defined spine, and then removes this material. The material can be made to respect one or more guide curves
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In P1 configuration, only two sections Multi-sections Solid can be created.
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Remove Multi-sections Solid Material



1



Select the Remove Multi-sections Solid Material icon



2



3



Select the sections the Multi-sections Solid is going to pass through. The order in which you select the sections is important, it will define the order of connection between the sections (You could have defined a spine or several guide lines, if no spine is selected, the system computes a spine for you)



(2a) (2b)



Copyright DASSAULT SYSTEMES



(1) (2c) (2e)
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(2d)



Select OK
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Closing Point & Orientation: Remove Multi-sections Solid
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Closing point of the section



Orientation of the section



When selecting another section, it may happen that the section is orientated in the other direction than the previous one, so, to reverse the section orientation select the arrow which indicates the section orientation
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To change the closing point of a section, select another point on this section
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Remove Multi-sections Solid Material : Tangent Surfaces



1



Select the first section



4



Select the last section



2



Select the surface (corresponding to the first section) the removed Multisections Solid will be tangent to 5
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You get :



(2)



(1)



(3)



(4)
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(5)



3



Select the intermediary sections



Select the surface (corresponding to the last section) the removed Multisections Solid will be tangent to



6



Validate



Result with the same sections but without any tangent surfaces



Part Design



Coupling
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You will learn how to use Coupling when creating Multi-sections Solids
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What is Coupling when Creating Multi-sections Solids? A Coupling tab in the Multi-sections Solid and remove Multi sections Solid functions allows you to compute the Multi-sections Solid using: The total length of the sections (ratio). The vertices of the sections. The curvature discontinuity points of the sections. The tangency discontinuity points of the sections.



Vertices, Curvature Discontinuity, Tangency Discontinuity
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Vertices, Curvature Discontinuity
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Vertex
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Coupling when Creating Multi-sections Solids The Coupling tab in the Multi-sections Solid and Remove Multi-sections Solid functions allows you to specify the Multi-sections Solid computation type: - on the total length of the sections (ratio) - between the vertices of the sections - between the curvature discontinuity points of the sections - between the tangency discontinuity points of the sections 1



Activate the Multi-sections Solid icon and select and orient the sections. (2)
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(1)



2



Select the Coupling tab from the dialog box



3



Select the desired kind of coupling from the combo



4



Select OK
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(3)



(4)
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Coupling when Creating Multi-sections Solids: Ratio The Coupling tab in the “Multi-sections Solid” and “Remove Multi-sections Solid” functions can be used to compute the Multi-sections Solid using the total length of the sections (ratio) 1



Activate the Multi-sections Solid icon and select and orient the sections.



(1) (2)
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You get :



2



Select the Coupling tab in the dialog box



3



Select Ratio from the combo



(3)



(4) 4



Select OK
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The solid is passing through the sections and the variation between the sections is computed by a ratio corresponding to the length of each section
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Coupling when Creating Multi-sections Solids: Tangency The Coupling tab in the Multi-sections Solid and Remove Multi-sections Solid functions can be used to compute the Multi-sections Solid between the tangency discontinuity points of the sections 1



Activate the Multi-sections Solid icon and select and orient the sections.



(1) (2) You get:
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2



3



4



Select the Coupling tab from the dialog box Select Tangency Discontinuities from the combo



Click OK
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(3)



(4)



The solid is passing through the sections and each section is split at each tangency discontinuity point. The solid is computed between each split section
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Coupling in Multi-sections Solids: Tangency then Curvature The Coupling tab in the Multi-sections Solid and Remove Multi-sections Solid functions can be used to compute the Multi-sections Solid between the curvature discontinuity points of the sections 1



Activate the Multi-sections Solid icon and select and orient the sections.



(1) (2) You get :
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2



3



4



Select the Coupling tab from the dialog box Select Curvature Discontinuities from the combo



Select OK
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(3)



(4)



The solid is passing through the sections and each section is split at each curvature discontinuity point. The solid is computed between each split section
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Coupling when Creating Multi-sections Solids: Vertices The Coupling tab in the Multi-sections Solid and Remove Multi-sections Solid functions can be used to compute the Multi-sections Solid between the vertices of the sections 1



Activate the Multi-sections Solid icon and select and orient the sections.



(1) (2)
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You get:



2



Select the Coupling tab in the dialog box



3



Select Vertices from the combo



(3)



(4) 4



Click OK
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The solid is passing through the sections and each section is split at each vertex. The solid is calculated between each split section



Part Design Student Notes:



Coupling creation: Points of Discontinuity There are different types of point that CATIA can use to split the sections when creating Multi-sections Solids using coupling To have a look at the different types of discontinuity, we have sketched the profile shown below :
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Segments



Two arcs
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These two points are tangency and curvature discontinuity points. They are also vertices



These two points are curvature discontinuity points. They are also vertices



This point is a tangency and curvature continuity point. This point is a pure vertex
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Multi-sections Solid Manual Coupling (1/2) When the sections to be Multi-sections Solid ,do not have the same number of vertices you can define manual coupling instead of changing or creating additional closing points. 1



Activate the Multi-sections Solid icon, select the sections and the guide curves (if necessary, change the section orientation)



Section 3



2



Select the Coupling tab then set the Sections coupling to Ratio



Guide 2 Guide 3



Guide 1 Section 2 Section 1 Double click in the Coupling field to display the Coupling window
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3
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You get:
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Multi-sections Solid Manual Coupling (2/2) When the sections to be Multi-sections Solid ,do not have the same number of vertices you can define manual coupling instead of changing or creating additional closing points. 4



For each section select the vertex for the coupling. selection must be made in the same order in which the sections were selected.You can visualize the coupling curve if the corresponding option is checked.



Coupling curves are displayed in green



c b
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5



a Click OK to end Multi-sections Solid surface definition
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Manual Coupling: Displaying Uncoupled Points(1/2) For each coupling mode, the points that could not be coupled are displayed in the geometry with specific symbols 1



Select the two sections which have different number of vertices and have some discontinuity in curvature and tangency Section 2



Apply the different coupling modes one by one



Section 1



An error is issued every time
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3



2
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For each coupling mode, the points that could not be coupled are displayed in the geometry with specific symbols
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Manual Coupling: Displaying Uncoupled Points(2/2) For each coupling mode, the points that could not be coupled are displayed in the geometry with specific symbols
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4a



Tangency mode



Tangency mode : uncoupled tangency discontinuity points are represented by a square
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4b



Tangency then curvature mode



Tangency the Curvature mode : Uncoupled curvature discontinuity points are represented by an empty circle



4c



Vertices mode



Vertices mode : uncoupled vertices are represented by a full circle
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Multi-sections Solid Relimitation (1/3) By default the Multi-sections Solid surface is limited by the start and end sections. However you can choose to limit it on the spine or on the guide lines extremities
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When the limitation option is checked, the Multi-sections Solid is limited to the start or (and) end sections even is a larger spine or guide curves have been used



Note: This is also possible with the Remove Multi-sections Solid command
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Multi-sections Solid Relimitation (2/3) By default the Multi-sections Solid surface is limited by the start and end sections. However you can choose to limit it on the spine or on the guide lines extremities
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When the limitation option is unchecked, and when a spine has been used, the Multi-sections Solid is limited by the spine extremities



Note: This is also possible with the Remove Multi-sections Solid command
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Multi-sections Solid Relimitation (3/3) By default the Multi-sections Solid surface is limited by the start and end sections. However you can choose to limit it on the spine or on the guide lines extremities
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When the limitation option is unchecked, and when guide lines have been used, the Multisections Solid is limited by the guide lines extremities



Note: This is also possible with the Remove Multi-sections Solid command
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Note: If a spine an guide lines have been used the Multi-sections Solid will be limited on the shorter line
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Changing the Closing Point
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You will learn how to change the closing point when creating a Multi-sections Solid
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What is Changing the Closing Point when Creating Multisections Solids ?
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When selecting the sections to create a Multi-sections Solid (or remove Multi-sections Solid), you can change the closing point after the selection of the sections and you can create a closing point anywhere on a section profile
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Changing the Closing Point in Multi-sections Solids (1/6) 1



Activate the Multi-sections Solid icon and select the first section



2



Select the second section
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First section
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3



Select the third section
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Changing the Closing Point in Multi-sections Solids (2/6) 4



Click on Section2 (Label)



5



Select Replace Closing Point in the contextual menu, then select a new closing point (5)



6



Click on Section3 (Label)



7



Select Replace Closing Point from the contextual menu, then select a new closing point (7)



8



Select the arrows to reverse Section2 and Section3



(8)



(7)



(5)
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(6)
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(4)
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Changing the Closing Point in Multi-sections Solids (3/6) 9



Check that the coupling is at Ratio then Select Preview in the dialog box
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(9)
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You can see that the solid is twisted because the default closing point of Section1 is not aligned with the closing points of the other sections
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Changing the Closing Point in Multi-sections Solids (4/6) 10



In order to create a closing point on Section1, select the Section1 label with MB3, then select Remove Closing Point



11



Then again, select Create Closing Point in the contextual menu



A new dialog box is displayed corresponding to the point creation on a curve
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(11)



(10)
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The point appears in blue before validation
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Changing the Closing Point in Multi-sections Solids (5/6)



Select the Distance on curve option



13



Select the Geodesic option and Enter 100 as the Length



14



Select OK
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Changing the Closing Point in Multi-sections Solids (6/6)



16



Select the Coupling tab



17



Select Vertices option from the combo
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You get :



18



Select OK
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Do It Yourself (1/6) Part used: Multi_Sections_Solid_Do_It
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Using the 3 visible Sketches, apply the different coupling modes and change the closing point Create the Multi-sections solid using the four coupling modes : Ratio, Tangency, Tangency then curvature, Vertices. Study the impact of various combinations. Analyze the warnings that you may get.



when ‘Tangency’ option is used, Points discontinuous in ‘tangency are coupled together
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when ‘Tangency then Curvature’ option’ is used, Points discontinuous in curvature are coupled together



Part Design



Do It Yourself (2/6) Create a new Multi- sections solid using one or several guide curves provided Differentiate the result from the result of the previous step. Sections
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Guide Curves



You will observe that the final result will take the shape of the Guide Curves provided. Also, note that the Guide curves MUST intersect the sections. When you use Guide Curves, CATIA computes the Multi section solid irrespective of the Coupling modes.
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Do It Yourself (3/6) Create a Multi-Sections solid using sketch provided in the geometrical set for step 3. You will get an error asking you to use a guide with a smaller curvature.
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You get this error, because if you edit the sketch you will see that one line is not horizontal but at an angle of 0.75 deg. To solve this error you need to provide ‘Angular Correction’ of 0.75 deg in MultiSections solid definition.



Angular correction option is helps to smooth the lofting motion along the reference guide curves. This may be necessary when small discontinuities are detected with regards to the spine tangency or the reference guide curves' normal. The Deviation option helps to smooth the lofting motion by deviating from the guide curve(s).
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Do It Yourself (4/6)
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Show the sketches in the geometrical set for step4. We will create a Multi sections solid by defining the spine. The Spine curve should be normal to the section plane and must be continuous in tangency. Also you can explicitly create Spine in the Generative Shape design workbench Here, you will make use of readymade Spine provided to you. You will create two Multi sections solids here: Create First Multi- section solid will use only the spine in part body Create Second Multi- section solid will use both the spine as well as the Guide curves in a new body.
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Do It Yourself (5/6)
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Now create the second Multi-sections solid using the spine as well as Guide curves in a new body Part body is Hidden for the time being.
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Do It Yourself (6/6) Now show the Part body. You can notice the differences between the two Multi section solids You can observe that spine only provides the shape to the solid. But when we also use Guide curves , the solid is created along Guide curves.



Second MultiSections solid
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First MultiSections solid
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Sketch-Based Features Recommendations
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You will see some hints, tips and advices about tools seen in the lesson



Copyright DASSAULT SYSTEMES



Student Notes:



Part Design



Editing sketch during Rib or Slot Creation or Edition You can edit the sketches of the profile and the center curve during the rib or slot creation or edition Access to the profile’s sketch
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Access to the center curve’s sketch
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Creating Sketch During Rib or Slot Creation
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If no sketch has been created when activating the Rib or Slot icon, you can access the Sketcher by selecting the Sketcher icon. When you have completed the sketch, you can exit the Sketcher and return to the Rib or Slot creation



Select the Sketcher icon in the dialog box
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You could have used the same method to define the Center curve



Student Notes:



Part Design



Using Sketch Sub-Elements to Create Ribs
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You can use sub-elements of a sketch to create ribs, like for pads or pockets
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Using Sketch Sub-Elements to Create Slots
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You can use sub-elements of a sketch to create slots, like for pads or pockets
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Using Sketch Sub-Elements to Create Stiffeners
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You can use sub-elements of a sketch to create stiffeners, like for pads or pockets
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Using Several Closed Profiles to Create Ribs and Slots You can create Ribs and Slots from sketches including several closed profiles. These profiles must not intersect
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Rib
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Slot
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Sketch Based Features: Recap Exercises You will Practice the concepts learnt in this lesson to build a exercise following a recommended process.
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Jewel Case Core
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Jewel Case Core Sketch Based Features: Recap Exercise 20 min
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In this exercise you will : Design the part to create the core geometry for the Jewel Case. Create combine from two profiles perpendicular to each other Design the strengthening and mating part rib on the back perimeter of the core geometry Design the relief Rib
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Design Process: Jewel Case Core 1 Create the rough design by combining the two profiles 2 Create Pockets



3
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Create strengthening Rib



4 Create another relief Rib on the central part of the Jewel Case
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Do It Yourself (1/11) Part used: PDG_Jewel_Case_Core_Start.CATPart Set the Length units to “Inches”, through: Tools > Options > Parameters and Measure > Units. Create a Combine from the two sketches given. Sketch.2



Sketch.1
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Combine
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Do It Yourself (2/11) Create another sketch on XY plane by projecting the edge of the combine. Create the remainder of the sketch using the Profile tool and trim it to form the closed profile for the Pocket.
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Projection
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Do It Yourself (3/11)
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Create a pocket using this sketch using “Up to Next” option.



Copyright DASSAULT SYSTEMES



Student Notes:



Part Design



Do It Yourself (4/11)
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Create another sketch on XY Plane Use the project 3D elements tool to project four bottom edges from the solid onto the sketch plane as shown. Trim the edges to form sharp edges.
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Do It Yourself (5/11)
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Create a pocket from this sketch
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Do It Yourself (6/11) You will now design the rib to strengthen the Jewel Case. First create a sketch on the top face of the Jewel case. This is the rib center curve. Use the Project 3D Elements tool to project three bottom edges from the solid onto the sketch plane as shown. Projections Complete the sketch.
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After projecting the edges, continue to create the sketch shown in black
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Do It Yourself (7/11) Mirror the sketch about the central line. This sketch is the center curve for the rib that you will create.
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Mirror about this line
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Do It Yourself (8/11) Now you will create the profile to be swept around this center curve using the Rib tool. Create a new plane (Offset 2.438in from the ZX plane) to support the sketch for this profile.



Plane
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Details of this sketch are:



Sketch on this plane
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Do It Yourself (9/11) Create a rib using the two sketches.
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Rib
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Do It Yourself (10/11) Create a relief rib for the Jewel Box. Create a sketch on the top face of the Jewel case core as shown for the center curve of a new rib. Create a new sketch for the rib profile using the same sketch plane you used for the strengthening rib profile. Create the half-circular profile as shown, constraining the lower corner point to the center curve profile.
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Plane.1



Center curve for rib
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Profile for rib
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Do It Yourself (11/11)
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Create a relief rib for the Jewel Box using these sketches.



PDG_Jewel_Case_Core_End.CATPart
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To Sum Up This concludes the lesson on the Sketch based features



You have learnt to create advanced sketch based features like Rib,Slot,Stiffener,Multi-Section solids Rib :Rib is feature that is created by sweeping a profile along a given part. Slot:Slot is a feature that removes material and is used in a similar way as Rib. Stiffener:A stiffener is a brace that is added to a wall to strengthen it and prevent breakage. it is mostly used in casting components. Multi-Sections solid: Multi-Sections solid is used to sweep several sections along a guided path. Removed Multi-sections solid is a feature similar to loft but the difference is that it removes material Multi-section solid can be created using guides,spines,couplings
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Multi-section solids can be relimited using Relimitation.
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Part Manipulations You will learn how to manipulate part elements
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Introduction to Part Manipulations Scanning a Part Design Using Boolean Operations Cut, Paste, Isolate, Break Sharing Geometries Sketch Selection with Multi-Document Links Part Manipulations Recommendations Part Manipulations: Recap Exercises Sum Up
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Introduction
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You will see in this lesson different tools used to manage features (cut, paste…), bodies (inserting, boolean operations), and how to create multi-model links
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Scanning the Part
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You will see how to replay the construction history of a part.
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What is Scanning a Part ?
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Scanning a part means to replay the construction history of a part and isolate temporarily any feature to work locally. By scanning a Part we can understand the complete steps that were followed to complete the design.
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Scanning the Design Process
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Here is a powerful tool to show the Part History step by step in order to visualize how the model is designed. Scanning the design is done through Edit > Scan or Define in work Object.



You can select ‘forward’ at each step to scan all steps
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Scanning a Part (1/2) 1



Select Edit > Scan ... Menu option



Initial part 2



Use the Scan tools to navigate through the part structure
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Structure: all feature are scan in the order of the specification tree Update: all features are scan in the order of the update



Starting feature: feature active when starting scanning Backward: goes to the previous feature in the tree First to Update: goes to the first element to update and update it Forward: goes to the next feature in the tree Exit: when you exit the active feature becomes in work (it is underlined in the tree)



Display Graph: Make a dialog box appear displaying all the features belonging to the part



Copyright DASSAULT SYSTEMES



Last feature: last feature in the tree Play Update: replay the update of the geometry
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Scanning a Part (2/2)



3



4 To work again on the whole part, click the last feature in the tree and select the Define in work option in the contextual menu (MB3)
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The Mirror.1 feature is in work: you can make local changes
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What is Define in work Object ? Define in Work Object :To create a intermediate feature especially during design modification stage, define in work object is used.This is done through contextual menu. Define in work objects is useful when working with several bodies (in Boolean operations) By using Define in work object you can create features in a body by working in that body.
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Here the entire part is created in the same part body
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But after creation of Pad.1 Body.2 is defined in work object then top part will be created in the second Body.



Part Design



Defining in Work Objects (1/2)
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1



Select a feature in the Tree with MB1



2



Select the Define in Work Object option in the contextual menu



Note that in the same Body, CATIA no longer displays features coming after the ‘active’ feature defined as in Work Object
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Defining in Work Object (2/2)



3



If you insert a new Sketch, it is positioned after the active feature(Feature that is underlined) defined as in Work.
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Here Pad.1 is Defined in work Object.
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Here Shell.1 is Defined in work Object.



Part Design



Design Using Boolean Operations You will learn to design parts using Boolean Operations and by managing bodies.



ADD
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REMOVE
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INTERSECT



Student Notes:



Part Design Student Notes:



What are Boolean Operations? The Three Basic types of Boolean operations are: 1.Add (Union):Adding two solids, combines the two solids such that they become one solid. The exterior surface looks the same, however the two objects now act as one unit and can moved, copied and manipulated as a single entity. 2.Remove (Subtraction): Using Boolean remove on two objects, the second objects is removed from the first object. The first object remains as it is, except the “volume” where the second object intersects the first object gets removed. 3.Intersect: Using Boolean intersection, the common volume or material to the two objects is kept. Object 2 in brown



Object 1 in Green
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ADD
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REMOVE



INTERSECT
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Why do we need Boolean Operations ?(1/3) We need Boolean operations for following Reasons: 1.Boolean approach facilitates design of complex parts. 2.To Optimize the design and Update of the part. 1. Design of Complex Parts Boolean ADD: For example, you want to create the following complex part.



It can be designed easily by using Boolean operations
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Create Material 1 first
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Then, create Material 2



Add them together so that a single object is formed.
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Why do we need Boolean Operations ?(2/3) Boolean operations are used to design the complex Parts Boolean REMOVE: For example, you want to create the following complex part.



It is required to get the precise fillet value here.
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It can be designed easily by using Boolean operations



Create Part 1 first
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Then, create Part 2



Remove Part 2 from Part 1 to get the final single part.
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Why do we need Boolean Operations ?(3/3) Boolean operations are used to design the complex Parts Boolean INTERSECT: For example, you want to create the following complex part.
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It can be designed easily by using Boolean operations



Create Part 1 first
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Then, create Part 2



Intersect part 1 and part 2 . Here Common part is kept



Part Design



How to Create Boolean Operations ? (1/2) To create Boolean operations we need parts designed in different bodies and not in in a single Part Body. At a given time Boolean Operations can be performed on two different bodies only. To perform Boolean operations between the bodies ,you need to insert bodies through Insert > Body.
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You can create different Design steps in these bodies separately. Now You will be able to perform operations (add, assemble,remove,intersect,union trim) to define relation between these bodies. For example, to create a molded part. You can create Main part of the Mold in one body and the core in another body, then you can remove the core from the main part. Later it will be easy for you to separate the part and its core.



Copyright DASSAULT SYSTEMES



Student Notes:



Part Design



How to create Boolean Operations? (2/2) Assembling/Adding :When Body2 is Assembled or Added with Body1, the operation between the bodies is a Union.The only difference between them is that Assemble will respect the “nature” of features. If Body2 contains Pocket feature (permissible) as its first node , Assemble will remove material from Body1. If Add is used, the Pocket will be seen by Body1 as a Pad. Intersecting : The resulting solid is the material common the two bodies. Removing : If Body2 is Removed from Body1, the operation is Body1 minus Body2
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Union Trim : The Union Trim is basically a Union with an option to remove or keep one side or the other. In the picture, the purple face is selected to be removed. For the Union Trim to work, the geometry must have sides that are clearly defined Remove Lump : All the above options work between two bodies. The Remove Lump works on geometry within a specific Body. “Lump” is the material that is completely disconnected from other parts in a single Body . The user can delete any Lump as a single entity even if the Lump is a combination of numerous features
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Assemble 1



2



With the cursor on Body.2, select Assemble from the contextual menu (MB3)



We want to assemble Body.2 with PartBody



3



Select OK in the Dialog box
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Body.2 contains a groove In a complex part, when features are numerous it is useful to group together some of them in a body which becomes a subassembly of the first body using Insert in new body tool.
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You get:



Because Body.2 contains a groove which is a feature that removes material, the result of the assemble operation is also removing material
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Add 1



2



With the cursor on Body.2, select Add from the contextual menu (MB3)



We want to add Body.2 in PartBody



3



Select OK in the Dialog box



You get:
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Body.2 contains a groove
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Body.2 contains a single groove, so it appears as a solid (even if it normally removes material). When you Add a Body, CATIA keeps the feature like it appears before the addition.
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Remove 1



2



With the cursor on Body.2, select Remove from the contextual menu (MB3)



3



Select OK in the Dialog box



We want to remove Body.2 from PartBody
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You get:
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Intersect 1



2



With the pointer on Body.2, select Intersect from the contextual menu (MB3)



3



Click OK in the Dialog box



We want to intersect Body.2 with PartBody



Copyright DASSAULT SYSTEMES



You get:
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Union Trimming Bodies 1



2



We want to do a Union Trim of Body.2 with PartBody



3



Select the Face to remove then the face to keep
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You get:
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4



With the pointer on Body.2, select Union Trim in the contextual menu (MB3)



Click OK
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Removing Lumps (1/3) After certain operations, it may happen that some Lumps or Cavities appear in the part. We need to remove them. The Remove Lump capability allows you to remove Lumps and Cavities Cavity



Pockets



Shell
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Lumps
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Removing Lumps (2/3) 1



With the pointer on PartBody, select Remove Lump in the contextual menu (MB3) 2



Select the ‘Faces to remove’ field in the dialog box
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3
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Select the two following faces belonging to the lumps to be removed
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Removing Lumps (3/3) 4



In order to select a face of the cavity, place the pointer on the cavity to be removed then press the Up arrow key of the keyboard



6



7



5



Using the small arrows, highlight one of the cavity face



To confirm the face selection click inside the circle



Click OK
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You get:
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Assembling a Set of Bodies (1/3) Assembling a set of bodies (Multi selected using the Ctrl key) is possible
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1
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Using the Ctrl key, select the three following bodies to be assembled



Student Notes:



Part Design



Assembling a Set of Bodies (2/3) With the cursor placed on the last body, select the Assemble option in the contextual menu
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2
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Assembling a Set of Bodies (3/3)



3



Select OK in the dialog box
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You get:
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What is Replacing a Body?
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You can replace a body used in an operation by another one
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Replacing a Body (1/3) Body to be replaced
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Replacing body
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1



Select the Replace command from Body.3 contextual menu



2



Select Body.4



Part Design



Replacing a Body (2/3) 3



Select the following line in the dialog box



Student Notes:



4



Select the following face in the Replace Viewer. This face is the face that will be removed during the Union Trim operation
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5
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6



Select OK



Select OK
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Replacing a Body (3/3)



7



If necessary, update the part by selecting the Update All icon
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You get:
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Changing the Boolean Operation Type (1/4) The initial part is composed of three bodies. Assemble Body.1 to Part Body.
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1
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2



Remove Body.2 from Assemble.1.You obtain Remove.1.
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Changing the Boolean Operation Type (2/4)



3



Click with the right button mouse on Remove.1. In the contextual menu, select Remove.1 object



4



Choose now the new operation. For example, click on Change To Assemble.



Copyright DASSAULT SYSTEMES



Student Notes:



Part Design



Changing the Boolean Operation Type (3/4) 5



You obtain :
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6
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Change now Assemble.2 to Union Trim. You obtain :
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Changing the Boolean Operation Type (4/4) You can edit Trim.1. For instance, select the cylinder' s top face as the face to keep. You obtain :
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Cut, Paste, Isolate, Break
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You will see how to cut or copy a feature and paste it into a body and you will also see how to isolate or break 3D geometry from its parents
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What is Cut/Copy and Paste (Drag and Drop)?



The operation Cut/Copy and then Paste captures the node specified into the clipboard and either replaces (Cut) or copies (Copy) the content into a different selected point in the part structure. The action is interpreted by the system in a context-sensitive manner. For example, if a pad is copied onto a different sketch, the new sketch is used for the profile and information on extrusion limits will be those of the pad. However, if pad1 is copied onto pad2, since this action has no real meaning, it is interpreted as generically copying the clipboard’s content into the part. The effect is to create another copy of pad1 (with its original sketch) in the part structure. This copy will be placed after whatever node is currently the “In Work” node.
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Cut/Copy then Paste can be achieved by using the drag and drop capability. If the CTRL key is pressed during the drag and drop, the action is interpreted as a copy otherwise as cut.
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Cut/Copy and Paste (Drag and Drop) (1/3) 1



Pad.3 is created on sketch.3 with the same limits as those in Pad.2
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3



Select the feature that you want to copy on another feature from the tree.Copy Pad.2
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2



paste the Pad feature on sketch.3.Select Sketch.3,click MB3,and select paste.
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Cut/Copy and Paste (Drag and Drop) (2/3) 4



Copy Draft.1 from the tree.Select the vertical face of the Pad.3 and Paste it using MB3.
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5
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Draft.2 is applied to Pad.3.
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Cut/Copy and Paste (Drag and Drop) (3/3) 6



Keeping the Ctrl Key pressed, select Edgefillet.1.
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Drag the selection and drop it on one of the edges of Draft.2.
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When to Use Isolate and Break?



• Isolate is used when 3D geometry is projected into a sketch in order to be modified and used as part of the sketch’s profile. Isolate duplicates the element since the original element cannot be changed because other geometry depends on it.
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• Break is used to divide an isolated element into two parts at a specified point (usually to use one side of this element in the sketch).
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Isolate, Break (1/3) Starting with the geometry as shown below, we want to add a pad.



1



2



Pad



Using the Trim and Break icon in the sketcher, modify the sketch as follows, then exit the sketcher.



Lines



Diameter 100



3



Copyright DASSAULT SYSTEMES



Intersection between the pad and the sketch plane
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Added pad



Diameter 50



Create a pad with an length of 20.
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Isolate, Break (2/3) Edit the Sketch of the first pad and change the circle diameter to 50.



4



6



5



Exit the sketcher (Sketch.1), if necessary, Update the part. You will get:



Select the Undo icon (may be several times) in order to come back to diameter 100
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Edit Sketch.2, place the cursor on the yellow line. Select Isolate from the contextual menu.
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Isolate, Break (3/3) 8



Create two Coincidence between the isolated arcs and the cylinder and exit the sketcher



9



Edit the Sketch (Sketch.1) of the first pad and change the circle diameter to 50
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Exit the sketcher, if necessary, Update the part. You will get:



Part Design



Sharing Geometries
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You will learn ways to Share Geometries using Multi-model links to help propagate design changes.
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Introduction Here you will learn to Share geometries between several parts by keeping the link. The link will be maintained between the Source part and the part in which copy is done.
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To do so, you will learn what are Multi Model Links
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What are Multi-Model Links ? The concept of working within an independent “Body” and then having the ability to Add, Remove, or Intersect this Body with your “Master” PartBody gives you added modeling flexibility
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There are different ways that an independently modeled Body can be assimilated into a PartBody
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Why do we need Multi-Model Links ?(1/2) In the context of the concurrent engineering, Multi-Model Links enable to keep the link between a copied element and its master. This allows to share geometries coming from different designers into your own part and it enables to update your part whenever different designers modify their design. Part Created By Designer A.
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By using MML Part B is Imported in Part A
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Part Created By Designer B.
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Why do we need Multi-Model Links ?(2/2) Part B is Removed from Part Using Boolean Operations
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Part B is modified by Designer B
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The changes are reflected in the Master design A on update.
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Establishing Multi-Model Links (1/3) 1



In a CATIA session you have two separate parts 2



Using the Contextual Menu, copy the PartBody of Part2
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Place the cursor on the PartBody of Part1 then Select Paste Special from the contextual menu
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Establishing Multi-Model Links (2/3) 3



In the dialog box, select As Result With Link and the Paste button, then select OK



4



Part1 becomes:
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In Sketch.1 of part1, create a distance (10mm) between the circle and the copied cylinder then exit the sketcher
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Establishing Multi-Model Links (3/3) 6



8



Now, in Sketch.1 of part2, create a diameter constraint of 50 then exit the sketcher



7



With Part1 active, select the Update All icon
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You get:



Copyright DASSAULT SYSTEMES



Part1 becomes:
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Sketch Selection with Multi-Document Links
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It is possible to copy and paste with link a sketch from a document to another one
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Sketch Selection with Multi-Document Links (1/5) You can copy a sketch in a document then paste it into another document keeping the link with the first one. You can use this copied sketch and in case the original sketch is modified, the document in which the copy is used will be also be modified
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1



2



After loading a part containing a sketch, start a new part using the File + New command



Display the two parts using the Window + Tile Horizontally command
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You get:
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Sketch Selection with Multi-Document Links (2/5) You can copy a sketch in a document then paste it into another document keeping the link with the first one. You can use this copied sketch and in case the original sketch is modified, the document in which the copy is used will be also be modified With the cursor on Sketch.1 in the tree, select the Copy command from the contextual menu (MB3)
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4



In the second part, place the cursor on PartBody, then select Paste Special from the contextual menu (MB3)
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Sketch Selection with Multi-Document Links (3/5) You can copy a sketch in a document then paste it into another document keeping the link with the first one. You can use this copied sketch and in case the original sketch is modified, the document in which the copy is used will be also be modified Select AsResultWithLink in the dialog box
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Expand Sketch.1 in order to see what has been copied (by selecting +)
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Sketch Selection with Multi-Document Links (4/5) You can copy a sketch in a document then paste it into another document keeping the link with the first one. You can use this copied sketch and in case the original sketch is modified, the document in which the copy is used will be also be modified
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Create a 20mm-high pad using the copied sketch
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In the first part, modify the sketch as shown below
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Sketch Selection with Multi-Document Links (5/5) You can copy a sketch in a document then paste it into another document keeping the link with the first one. You can use this copied sketch and in case the original sketch is modified, the document in which the copy is used will be also be modified 9



To take the modification into account in the second part (the one which contains the copied sketch), place the cursor on Part2 then select the Part2object + Update All Links command
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You get:
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Part Manipulations Recommendations
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You will see some hints, tips and advices about tools seen in the lesson
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The Different Paste Special Options (1/3)



As specified in Part document: The copied element can be modified and has no link with the original one. The original element is duplicated
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As Result With Link: The copied element cannot be modified, but in case of modification of the original element, the copied one is updated
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As Result: The copied element cannot be modified (it is a datum) and in case of modification of the original element, the copied one is not updated
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The Different Paste Special Options (2/3) As Result With Link You can edit the link of the solid which has been pasted in the same part using the option ‘As Result With Link’.



Consider the following scenario: Two different configurations of Cavity Pockets are stored in the two bodies namely: Cavity Pockets V1 and Cavity Pockets V2 Solid.9 is linked to one of the Cavity Pockets bodies and is used in Boolean operation with the part body. By changing the parent link of Solid.9 you can obtain the required design configuration.
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Cavity Pockets



User can only select Bodies within the Part in which the Solid is defined.
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The Different Paste Special Options (3/3) To change the parent of the pasted solid double-click its representation in the specification tree.



2



Select the another input for the solid as ‘Cavity Pocket V2’.
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Solid.9 has been created by copying the ‘Cavity Pockets V1’ body and pasting it in the same part using the paste special option ‘As Result With Link’.



The design has been changed to accommodate new Cavity Pockets



Part Design
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Copying and Pasting Sketches



To paste a sketch from one document to another, right click the destination plane / face and select paste from the contextual menu. This method can avoid task of changing the sketch support which may be required later.
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Isolating Sketch Links
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You can create an Implicit Projection by making dimensional or geometrical constraints between your sketch geometry and 3D elements outside the sketch.



If you display the Implicit Projection in Sketch Analysis, you can Isolate the projection even though no explicit geometry exists. This process creates the appropriate construction geometry in the sketch which is isolated from the original 3D elements.
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Part Manipulations Recap Exercises 35 min



In this step you will create:
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Adding and Assembling Bodies Creating Union/Trim bodies Copy/Paste Special bodies Modifying Linked Geometry Copying and Pasting Geometry within a Part Copying and Pasting Geometry from one Part to Another Part Creating 3D Constraints between Bodies Connect Curves
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Design Process: Bracket-Right



The process steps used to complete the exercise:



1. Create new body



Copyright DASSAULT SYSTEMES



4. Apply Symmetry to create Left Bracket



5. Add additional feature to Left Bracket
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2. Union Trim the Bodies



3. Copy/Paste Special



6. Modify Right Bracket
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Design Process: Final Jewel Case



The process steps used to complete the exercise:



1. Replicate the strengthening rib and make modifications to it
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2. Copy Isolated geometry from another part for reuse



3. Copy geometry with history from another part for reuse
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4. Add and Assemble bodies



Part Design



Bracket-Right Recap Add New design Feature as Separate Part Body Union Trim two bodies Use Copy/Paste Special to copy this design to a new part document Use Symmetry command to create the left handed Bracket Add hole feature which makes the left handed bracket different from the right handed bracket
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Modify the hole feature of the right-handed bracket, which will also modify the hoel feature of the left-handed bracket because of the links.
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Final Jewel Case Recap Design intent to use existing features to finish the Jewel Case design Created an additional strengthening and mating part Rib by copying and then modifying the existing one Copied and Pasted as Result (isolated solid) features from another part to create CD placement ring Copied and Pasted features as Specified in Document to create flex openings for CD holder
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Added and Assembled bodies to complete the part



Copyright DASSAULT SYSTEMES



Student Notes:



Part Design



To Sum Up This concludes the lesson on the Part Manipulation tools. Boolean operations are used to design complex parts. Boolean operations are performed between two bodies at a time. Body is inserted through Insert > Body. Different Boolean operations are Add Remove Intersect Assemble Union Trim
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Remove Lump:Used on the body on which Boolean operations are already performed. Multi-Model links are used to propagate the design changes for one part to another. Features can be dragged from one location to another ,also they can be copied. This is covered under Cut,Copy,Isolate, Break.
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Dress-Up Features You will learn how to create advanced dress-up features
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Introduction to Dress-Up Features Advanced Drafts Thickness Removing Faces Replacing a Face with a Surface Dress Up Features Recommendations Dress-Up Features: Recap Exercises Sum Up
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Introduction The following advanced tools allow you to dress-up existing solids Advanced Drafts: This tool allows you to create complex drafts with a parting element or a reflect line:



Thickness: This tool is useful when you want to add a thickness to a face:



Remove Faces:
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This tool is useful when you want to simplify the geometry of a part for down stream processes:



Replace a Face with a Surface: This tool is useful when you want to have a portion of the solid be extruded to a surface:
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Advanced Drafts
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In this lesson you will see the Advanced Draft feature
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What is the Advanced Draft? (1/5) The Advanced Draft tool lets you draft basic parts or parts with reflect lines. It also lets you specify two different angle values for drafting complex parts. This task shows you how to draft two faces with reflect lines by specifying two different angle values and using the two available modes.



By default, the Advanced Draft toolbar is not accessible from CATIA, so in order to get it, you will have to select
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Views -> Toolbars -> Advanced Dress-Up Features



You will see the following toolbar:
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What is the Advanced Draft? (2/5) The Advanced Draft tool gives you the option to define standard draft as well as draft with reflect line on one or two sides. To do so, you will have to activate one or two buttons as described hereafter.
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Standard Draft (1st side)



Standard Draft (1st and 2nd Side)
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Draft reflect line (1st side)



Draft reflect line (1st and 2nd side)
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What is the Advanced Draft? (3/5) The 1st side tab is used to define the characteristics of the draft angle for the selected faces. If you decide to draft both sides, you have to define the draft angle characteristics for the second side using the 2nd side tab. When drafting both sides with reflect lines, you define whether the draft angles are independent or not.



To define if the angles are the same or not when using draft with reflect line. To define the draft angle value. To define the Faces to be drafted.
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To define the neutral element.



To define the pulling direction.
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What is the Advanced Draft? (4/5) To define the Parting Element, you have to use the parting tab. The parting element can be a plane, a surface or a face
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To define the parting element
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What is the Advanced Draft? (5/5) When you decide to draft both sides with independent angles, you have to define the second side characteristics



To define the draft angle value
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Neutral element



To define the pulling direction
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Advanced Draft Angle: Draft Both Sides (1/9) You are going to see how to draft both sides using the Advanced Draft icon



1



Select the Advanced Draft icon
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2
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Activate these two buttons
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Advanced Draft Angle: Draft Both Sides (2/9) Select this face as the object to be drafted
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Advanced Draft Angle: Draft Both Sides (3/9) Select the indicated plane
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Advanced Draft Angle: Draft Both Sides (4/9) Enter 21 in the angle field
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Select the Parting Element tab
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Advanced Draft Angle: Draft Both Sides (5/9) Select the Parting Element button
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Select the Parting Element field
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Advanced Draft Angle: Draft Both Sides (6/9) 10 9



Select the 2nd Side tab



Select the indicated plane
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Select the required plane from tree or user can create plane by right clicking in selection menu as shown below
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Advanced Draft Angle: Draft Both Sides (7/9) Select the indicated plane
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Advanced Draft Angle: Draft Both Sides (8/9) Enter 45 in the angle field
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Select Preview
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Advanced Draft Angle: Draft Both Sides (9/9) You will see



Copyright DASSAULT SYSTEMES



14



Copyright DASSAULT SYSTEMES



You get:



Select OK in the dialog box
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Do It Yourself (1/2) Second Neutral Element



Parting Element



6 degrees First Neutral Element



Face to define the Pulling Direction
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• Create a draft angle with the above indications. This draft angle is both sides with reflect lines
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10 degrees



Part Design



Do It Yourself (2/2)
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• Modify the previously created draft angle by making the first angle value as the driving angle (Driving/Driven option)
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Thickness
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You will see how to add material on a face by defining a thickness
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Why Applying Thickness?(1/2)



Applying thickness is basically used to enhance the productivity during solid model creation. A standard use of thickness is to add or remove material before machining a part. Thickness enhances the design intent and allows rapid modifications. Thickness is useful when you need to add material to various faces on a Part to accommodate machining or other manufacturing operations. For instance, you might add Thickness to account for additional material necessary to cast the part.
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Thickness is also applied to select walls of a Part that has been Shelled.
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Why Applying Thickness?(2/2) Now suppose we want to add thickness to one of the faces of the following part.



One of the methods is to create a pad,by selecting the face and specifying the length value.



Here you can observe that the filleted portion cannot be thickened in the Pad.To Pad that portion the number of steps would increase.
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By using the thickness tool we can solve this problem quickly and efficiently.
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Creating a Thickness (1/2) Select Thickness icon from Dress-Up features toolbar.



2



Select the faces to thicken.



3



Insert 10 as the Default thickness value.



4



Thickness is applied to the selected faces.
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Creating a Thickness (2/2) 5



Now we want add different thickness value to other faces.To edit the feature,double click on the specification tree to open the thickness definition dialog box.



6



Select the indicated faces and enter the thickness value as 5mm.



Enter 5 mm.



The thickness applied to the other faces ,maintains the same relation with the other features.Here the thickness is created along the the two cylinders.
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Removing Faces
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You will see how to simplify a part by removing some of its faces or features.
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Why would you use this tool ? When a part is to complex for of a finite element analysis you can remove some of its faces or features to simplify the geometry. Remove Faces ICON
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The feature in the Specification Tree contains the part without the removed features
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Removing Faces



Select Remove Face tool
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1
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2 Select internal faces



which have to be removed



3



Contextual menu of Faces to remove field allows to select tangency propagation option which automatically removes all faces tangent to the selected ones. Faces are removed and a new feature is created in the specification tree



Part Design



Do it Yourself Part used: PDG_Removing_Faces_Start.CATPart
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Remove internal faces of the keyway using Remove Face tool.
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Replacing a Solid Face with a Surface
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You will see how to replace a Face of a Solid by extruding it up to an external surface.
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Extruding a Solid Face Up To a Surface 2 Select the replacing surface and 1



Select the Replace Face tool



click the arrow to make it pointing in the kept material direction
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4



Select the face to extrude



You get the selected face extruded up to the replacing surface. Replace Face feature is added in the specification tree



Part Design



Exercise Replacing a Face with a Surface : Recap Exercise 5 min
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In this exercise you will extrude the bottom face of the solid up to the surface.
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Do it Yourself … Part used: PDG_Extruding_Solid_Face_Up_To_Surface_Start.CATPart
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Extrude the bottom face up to the yellow surface.
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Dress Up Features Recommendations
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You will see some hints, tips and advices about tools seen in the lesson
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Ignoring Faces When Creating a Thickness In some cases, when you want to create an Offset, an error message appears informing you that the Body can’t built properly. After closing the window, another message appears proposing you to Ignore the Faces causing trouble. If you accept, the Thickness is created and the Face causing trouble is removed. For example, here we want to offset the selected Face but it is not possible. The Face causing trouble is the Radius Fillet.
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We accept to ignore the Fillet, thus the Thickened Body becomes :



Copyright DASSAULT SYSTEMES



Student Notes:



Part Design



Reset Ignored Faces Option for Thickness Tool If we edit the Thickness from the specification tree, the Ignored Faces are previewed :
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The option “Reset Ignored Faces” appears in the Thickness Definition Dialog box. After selecting this option, the Ignored Faces are reinitialized and the indication “Ignored Face” in the geometry is removed.
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Extracting Geometry to Add Thickness



In some cases, you have to use the “Extract” command in order to add thickness. With this command, you can generate separate Elements from initial geometry, without deleting geometry. This command is available after clicking a Dialog box prompting you to deactivate the Thickness feature and Extract the geometry. Once this operation has been done, a node “Extracted Geometry” is displayed in the tree.
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If the Generative Shape Design Workbench is installed, the geometry resulting from the Extract operation is associative.
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Dress-Up Features: Recap Exercises You will Practice the concepts learnt in this lesson to build a exercise following a recommended process.
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Plastic Molded Bracket Crank Handle Bracket
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Plastic Molded Bracket Dress-Up Features Recap Exercise 15 min
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In this exercise you will : Design the part to use it in an assembly and prepare it for manufacturing. Design the Rough Part and make it thicker in order to meet the manufacturing requirements. Apply a Draft to enable its withdrawal by Molding manufacturing process. Apply Fillets. Create threaded Holes.
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Design Process: Plastic Molded Bracket 1 Create the rough design by combining the two profiles 2 Apply drafts with different values



3 Apply Fillets
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4 Create Holes. Apply threads to them.
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Do It Yourself (1/5) PDG_Plastic_Molded_Bracket_Start.CATPart



Set the Length units to “Inches”, using: Tools > Options > Parameters and Measure > Units. Create a Combine from the two sketches given. Apply thickness of 0.15 inches to the Six faces shown.



Sketch.1
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Sketch.2
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The 6 faces includes top and bottom faces
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Do It Yourself (2/5) Apply advanced draft with following specifications: Select Standard First and Second Side draft. Number of faces to draft = 6. Neutral element = ZX plane. Draft angle value = 5 deg.



Select these three faces
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ZX Plane
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Also Select these three faces from bottom side
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Do It Yourself (3/5) In the same Draft definition, access “Parting Element” tab Use Parting Element as ZX plane.
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In the “2nd Side” tab set the following values: Draft this side by 4 deg.
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Do It Yourself (4/5) Apply edge fillet of 0.75 inches to the 8 edges. Create two Holes of 1 Inch diameter, concentric with the Circular edge.
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Holes of 1 Inch diameter
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Do It Yourself (5/5)
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Apply Threads to both the holes.



PDG_Plastic_Molded_Bracket_End.CATPart



Copyright DASSAULT SYSTEMES



Student Notes:



Part Design



Crank Handle Bracket Dress- Up Features Recap Exercise 20 min
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In this exercise you will : Design the part to use it in an assembly and prepare it for manufacturing. Create a Pad apply fillet on it. Add advanced draft to add material to part with non symmetrical parting surface. Apply advanced draft with different angle values above and below the parting surface.
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Design Process: Crank Handle Bracket 1 Create the part main body



2 Apply Advanced Draft 3 Create end Pads



4 Apply advanced drafts to the ends



5
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Mirror the part
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Do It Yourself (1/8) PDG_Crank_Handle_Bracket_Start.CATPart
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Set the Length units to “Millimeter”, through: Tools > Options > Parameters and Measure > Units. Create a pad of 20 mm from the the sketch provided. Apply a draft of 2 deg to the face shown.
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Do It Yourself (2/8) Apply a variable radius fillet to the 4 elements as shown Fillet of 4 mm at this end
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Fillet of 6 mm at this end
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Do It Yourself (3/8) Prepare the part for the manufacturing process by applying Advanced Drafts Click the Advanced Draft tool and specify Reflect Draft First Side and Second Side with following specifications: Select Driving/Driven option from the list. Apply a draft of 4 deg and make sure that option “Driving side” is ON. Set the pulling direction to be the Z-Axis. (Hint: Use the contextual menu). Select any one fillet surface from the top fillet to be the neutral Element.
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Draft angle of 4 deg
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Do It Yourself (4/8) Select the parting element tab and select extrude.1 as the parting surface.
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Select 2nd side tab Select any one fillet surface from the bottom fillet to be the neutral Element
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Advanced draft is created
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Do It Yourself (5/8)
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Create a pad feature from sketch.2 with a height of 30mm Create another pad feature from sketch.3 with a height of 50mm.
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Do It Yourself (6/8) Prepare the part for the manufacturing process by applying Advanced Drafts to the ends. Click the Advanced Draft tool and specify Standard Draft First Side and second side. Select the two cylindrical faces as the faces to Draft. Key in 4deg for the 1st side Angle. Make sure the option “ Neutral=Parting” is selected. Use the XY plane as the pulling direction.
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Standard first side and second side
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Do It Yourself (7/8) Click the parting element tab in the dialog box and specify Extrude.1 as the parting element
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Click the 2nd Side tab. Set the Draft Angle to 6deg for this side. Make sure the option “Neutral=Parting” is selected.
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Do It Yourself (8/8) Advanced Draft is created. Finish the part using Mirror:Click the mirror command and use the flat surface as the mirroring element.
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Advanced Draft



PDG_Crank_Handle_Bracket_End.CATPart
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To Sum Up This concludes the lesson on the Dress up features



You have seen the Possibilities of Advanced drafts. Using apply thickness tool enables to apply thickness to a solid and helps to improve the productivity during Modification stage.
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By removing faces you can remove the faces of a complex solid so as to easily perform Finite element analysis.
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Part Analysis You will learn how to use different kinds of analyzing tools
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Introduction to Part Analysis Analyzing Threads and Taps Draft Analysis Surfacic Curvature Analysis Part Analysis: Recap Exercises Sum Up
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Introduction Different kinds of analysis tools are available:



Threads and Taps Analysis: Useful when you want to visualize threads and taps contained in a part and to have all information about them:



Draft Analysis:
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This tool is used to analyze the ability of a part to be extracted for mold design:



Surfacic Curvature Analysis: Used to detect defaults on high quality surfaces:
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Analyzing Threads and Taps
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You will learn how to display and filter out information about threads and taps contained in a part
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What is Thread and Tap Analysis ? When a part has been created with threads and taps, CATIA does not physically display these features. There is a way to quickly know all the information about threads and taps by using the Thread and Tap Analysis icon • You can display threads or taps or both



• You can display the threads and taps numerical values
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• You can display threads or/and taps of a given diameter value
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Analyzing Threads and Taps (1/2) You can display and filter out information about threads and taps contained in a Part



1



3



Select the Tap – Thread Analysis icon To show the threads or taps geometry
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2
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Select the criteria that will define the types of thread / tap that will be displayed To show threads



Expand the dialog box using the More button



To show taps



To show the threads or taps values



To show diameters with a given value



Part Design Student Notes:



Analyzing Threads and Taps (2/2) Select Apply in the dialog box
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You get:



Part Design



Draft Analysis
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You will learn how to use the Draft Analysis tool to analyze the Draft values.
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Why Analyze Draft? For mold design, Drafts need to be analyzed to determine the ability of the part to be extracted.
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This type of analysis is based on color ranges identifying zones on the analyzed element where the deviation from the Draft direction at any point, corresponds to specified values.
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Draft Analysis (1/3) 1



Select the Material option in the View -> Render Style -> Customized View command to see the analysis results on the selected element.



2



Select the Draft Analysis icon



3



In the Draft Analysis dialog box, choose the quick analysis mode (default mode) or the full analysis mode.



and the element you want to analyze.



4 Double-click a color to modify the values
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in the color range or a value to modify the edition values.



Quick



Copyright DASSAULT SYSTEMES



Full
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Draft Analysis (2/3) 4 You can activate the fly analysis check box and move the pointer over the surface. This option allows you to perform a local analysis.
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The displayed value indicates the angle between the draft direction and the tangent to the surface at the current point.
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Arrows are displayed under the pointer: Green arrow is the normal to the surface at the pointer location, red represent draft direction and blue arrow is the tangent.



Part Design



Draft Analysis (3/3) 5 Select



to define the new current draft direction.



A compass giving the current draft direction is displayed (the draft direction is the w axis of the compass).
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You can edit the compass proprieties to precisely define the draft direction.



The red areas represents all that cannot be extracted with the current draft direction.
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Surfacic Curvature Analysis
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You will learn how to use the Mapping Analysis tool to analyze surface curvature.
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Why Curvature Analysis? Curvature analysis of surfaces in generally used to help model high quality surfaces ie to detect the defaults on high quality surfaces. The Mapping analysis tool allows you to measure minimum and maximum curvature values of a point, the mean value (Gaussian analysis) and to see the inflection areas.
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Gaussian



Minimum (Maximum) : to display the minimum (maximum) curvature value.
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Inflection area : to define the curvature orientation. In green : areas where the minimum and maximum curvatures have a same orientation, In blue : they have opposite orientation.



Limited : to check if tool with an end radius can mill the part.
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Performing a Surfacic Curvature Analysis 1



Select the Material option in the View -> Render Style -> Customized View command to see the analysis results on the selected element.



2



Select the Curvature Mapping icon examine the curvature.



3



The Surfacic Curvature dialog box appears. Select Gaussian as Analysis Type.



and the surface where you want to



4 Adjust the color range fields right clicking on the thresholds values.



… you obtain :



Copyright DASSAULT SYSTEMES



On the fly enables to perform a local analysis
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Part Analysis Exercises Recap Exercises 25 min



In this step you will create :
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Performing a Curvature Analysis Performing a Structure Scan Object Performing an Update Scan Object Performing a Tap and Thread Analysis Performing a Draft Analysis
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Design Process: Wrench Analysis



The process steps used to complete the exercise:



1. Perform a Gaussian Curvature Analysis
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2. Modify the analysis color scale display
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3. Perform an Inflection Analysis



Part Design



Design Process: Flanged Connector



The process steps used to complete the exercise:
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1. Scan the relationship of features in the Part



2. Analyze Tap and Thread information in the Part
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3. Analyze selected features of the Part for manufacturability through Draft Angle ranges
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Part Design



Wrench Analysis Recap Design intent to analyze the curvature of a wrench design having many curved surface features Performed a Gaussian curvature analysis Modified the color scale values and colors for better clarity of the analysis
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Performed a curvature inflection analysis
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Flanged Connector Recap Performed a Scan Analysis for features in Structure Mode Performed a Scan Analysis for features in Update Mode Analyzed Tap and Thread information for the Part
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Performed a Draft Analysis for selected features on the part to determine manufacturability
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To Sum Up This concludes the lesson on the Part Analysis tools. You have learned how to:



Analyze Threads and Taps:Used when you want to visualize threads and taps in a part and to have all information about them>you can apply filters on the selection. Analyze Drafts:This tool is used to analyze whether a part can be extracted for mold design.A Color range is displayed identifying different zones of the analyzed part.
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Analyze Surfacic Curvature:Used to detect faults on high quality surfaces.
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Annotations You will learn how to add annotations in the 3D area
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Introduction to Annotations Text with Leader Flag Note with Leader Annotations Recommendations Annotations: Recap Exercises Sum Up
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Introduction You will see how to add text information attached to a part in the 3D geometry



Text with Leader: This tool allows you to add text attached to a part:



Flag Note with Leader:
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This tool allows you to add flag note attached to a part :
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Text with Leader
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You will learn how to attach a text to a part
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What are Texts with Leader ? A text with leader can be attached to a part in order to give information for example on surface treatment. This text can appear on the drawing



Text
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Leader
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Texts with Leader Select the position of the leader on the part



1



Select the Text with Leader icon



4



Place the text and the leader by dragging the arrow or the square points



2



3



Enter the text in the dialog box then select OK
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You get:
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Do It Yourself CATPDG_Doit_Text_with_Leader.CATPart
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• Create the following text with leader
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Flag Note with Leader



Copyright DASSAULT SYSTEMES



You will learn how to add hyperlinks to your document and then use them to jump to a variety of locations
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What are Flag Notes with Leader?
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A flag note with leader can be attached to a part in order to give information for example on surface treatment. This flag is an hyperlink that can start any documents such as a presentation, a Microsoft Excel spreadsheet or a HTML page on the intranet
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Flag Notes with Leader (1/2)



1



Select the Flag Note with Leader icon



2



Select the position of the leader on the part
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3
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Enter Part Process in the Name field



Part Design Student Notes:



Flag Notes with Leader (2/2) 4



Select the Browse button then select the file you want to link then select OK



Place the text and the leader by dragging the arrow or the square points
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5



Copyright DASSAULT SYSTEMES



You get:
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Using Flag Notes with Leader 1



Double click on the flag



2



Select the Link in the dialog box
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3
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Select the Go to button in the dialog box



The linked file is now started
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Annotations Recommendations
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You will see some hints, tips and advices about tools seen in the lesson
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Modifying a Text With Leader



To Modify the text of a text with leader, double click on the text, you will recover the dialog box where you can change the text
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Double click



Using the Properties command in the contextual menu will give you access to text, font and graphic modifications
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Modifying The Text of a Flag Note With Leader



To Modify the text of a flag note with leader, double click on the text, you will recover the dialog box where you can change the text
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Double click



Using the Properties option in the contextual menu will give you access to text, font and graphic modifications You can have several files linked to a flag note
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Repositioning 3D Annotation



You can use the Handles to reposition and resize the Annotation feature.



Use this handle to reposition the Annotation along its leader line



Use this handle to reposition the end of the arrow



Use top or bottom handles to move the Annotation up and down Use this handle to reposition the arrowhead
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Use middle handles to adjust the width of the Annotation box
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Changing 3D Annotation Properties You can modify the graphic, feature and other Properties of an Annotation through contextual menus.



Use the Properties menu to modify font color, size, feature name and other properties of the Annotation
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Use these contextual menus to modify other aspects of the Annotation
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Annotations Exercises Recap Exercises 25 min



In this step you will create:
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Creating text with a leader Creating a flag note with a leader Creating a projection view Viewing hyperlinks
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Sensor Well Exercise: Design Process



The process steps used to complete the exercise:



1. Create a text note to identify a design issue
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2. Define a new annotation projection view
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3. Create a flag note with a hyperlink to a specification document



Part Design



Bracket Annotation Exercise: Design Process



The process steps used to complete the exercise: 1. Create 3D Text
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2. Create Flag Note
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3. View Hyperlink
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Sensor Well Recap Design intent to create a note to identify a design issue and a flag note with a linked specification document Created a text note with a leader attached to the end surface of the part Created a new annotation projection view
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Created a flag note with a hyperlinked Excel document
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Bracket Annotations Recap Design intent to create a note to explain a design change and a flag note with a linked manufacturing document Created a text note in the part Created a flag note in the part including a hyperlink to a Word document
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View the contents of the hyperlink
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To Sum Up This concludes the lesson on the annotation tools. You have learned how to:
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Create Text with Leader Create Flag Note with Leader
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Congratulations



In this course you have learned how to design parts using advanced tools and to analyse and manipulate parts …
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In addition, you have built a mobile ‘Phone Bottom Case’ following a recommended design process ...
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